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Results of Support Staff Technology Survey 
 

By: Carole L. Colburn 
 
I recently surveyed all support staff to get a feel for technology comfort and 
training needs. The survey was sent to sixty-three people and forty-six 
people responded. From these answers, I will be able to plan technology 
training that more specifically meets the needs of the support staff. 
Following are charted results of each question.  
 
 
 
 

1. How often do you use Outlook E-mail?

0
5

10
15
20
25
30
35
40
45
50

Not 
at 

all

Mini
mall

y

Occ
as

sio
na

lly

Freq
ue

ntl
y

bla
nk

N
um

be
r o

f R
es

po
ns

es

 
 

2. How often do you use Outlook Calendar?
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3. How often do you use Outlook Tasks?
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4. How often do you use Outlook Contacts?
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5. How often do you use Excel?
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6. How often do you use Word?
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7. How often do you use Publisher?
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8. How often do you use Power Point?
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9. Other programs you use frequently.
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10. Other peripherals use frequently.
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11. Training needed in Outlook E-mail
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12. Training needed in Outlook Calendar.
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13. Training needed in Outlook Tasks.
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14. Training needed in Outlook Contacts.
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15. Training needed in Excel.
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16. Training needed in Word.
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17. Training needed in Publisher
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18. Training needed in Power Point.
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19. Extensive training needed in the following 
programs.
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20. Extensive training needed in the following 
peripherals.
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21.Would you prefer to attend training before 
school?
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22. Would you prefer to attend training after 
school?
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23. Would you prefer to attend training Fri. 
night/Sat.?
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24. Would you prefer to attend training in the 
summer?
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Back to Top of Page 
 
FYI: I am looking for teachers and students to showcase in the new “Spotlight 
On…” section of my web page. http://www.howellschools.com/~training Take a 
peek at this months focus teacher, Mrs. Thompson from Highlander Way Middle 
School and in particular the work of her students! If you would like to have your 
terrific technology lessons and student work showcased, please send me an email 
at colburnc@howellschools.com so I can set up a time to meet with you. Thanks! 
☺ You are doing outstanding work in the classroom and the proof is in the 
pudding, so to speak…the work of the students. Let’s let the community (and the 
whole world for that matter) see for themselves!  

 

Back to Top of Page 
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Lesson Plan of the Month 

The following lesson plan comes from www.microsoft.com/education 
 
Lesson Plan Title: Boning Up on Your Bones (The Human Skeletal System) 
Grades: 3-5 
Curriculum Connections: Science and technology  
 
Standards Connection: Arizona State Frameworks/Content Standards/Benchmarks  
(I know these are not Michigan standards, but I suspect that they are close and if you really 
wanted to use this lesson, you could align with the Michigan standards as well.)  

• Science Standard 4 Life Science  
 
4SC-E4: Identify the systems involved in such vital functions as digestion, respiration, reproduction, circulation, 
excretion, movement, control, coordination.  
PO 2: Identify the functions of systems (e.g., digestion, respiration, reproduction, circulation, excretion, 
movement, control, coordination). 

• Technology Standards  
 
3T-E1: Use formatting capabilities of technology tools for communicating and illustrating.  
PO 1: Use word-processing editing tools to revise a document (e.g., cut and paste, tabs and margins, font size, 
font style, delete and undo, selecting, spell check, click and drag).  
PO 2: Design a word-processing document with graphical elements (e.g., clip art, digital photographs, symbols, 
using text wrap, cropping, sizing, drawing tools).  
3T-E3: Publish and present information using technology tools.  
PO 1: Design and create a multimedia presentation or Web page using multiple digital sources.  
PO 2: Publish or present the above production.  

Required Software: Microsoft® PowerPoint®, Microsoft Publisher 2002, Microsoft Internet 
Explorer 
 
What's in this Lesson:  

• Teacher Guide (including How to Begin)  

 

Teacher Guide 
 

Summary: 
 

How many bones are in the human skeletal system? Which is the longest? The smallest? In this 
month-long unit, students "bone up on their bones" (and learn all about the human skeletal 
system) by creating and sharing multimedia presentations, newsletters, and Web sites. The unit 
consists of twenty 45-minute sessions that include direct instruction by the teacher as well as 
hands-on time for the students to use Microsoft PowerPoint and Microsoft Publisher to 
demonstrate their mastery of the instructional material.  
Objectives: 

 
Students work in pairs to predict, create, analyze, and report information about the human 
skeletal system. In the process they are able to:  
   
  

http://www.microsoft.com/education
http://www.microsoft.com/education/


   

   
  

• Describe what the skeletal system is (the number of bones and what bones are made of)  

• Describe at least two ways in which our bones protect our body  

• Describe how our bones enable movement  

• Define why human growth occurs  

• State ways to keep our bones healthy  

Students construct new information based on the bulleted list above and then present that 
information in a multimedia presentation. They are given a PowerPoint template for this 
presentation, as well as the rubric by which it is graded. 
 
Then students, working with a different partner, present information related to the bulleted list 
above in a newsletter. They are given a Publisher template for this presentation, as well as the 
rubric by which it is graded. 
 
Finally, student’s work with another partner to present information related to the bulleted list in a 
Web page. They are given a Publisher template for this presentation and are instructed on how to 
save the file in HTML format. They are also given the rubric by which the Web site is graded.  
Prerequisite Skills: 

 

• Basic computer operations and concepts  

• Basic understanding of technology communication tools  

Time Allotted: 
 

Twenty 45-minute class periods, plus additional time for students to become familiar with 
PowerPoint and Publisher software.  
How to Begin: 

 
Week 1: Engage students in a dialogue about the human skeletal system. Ask: "What do you 
know about the bones in your body? What else would you like to know about the human skeletal 
system? Where do you think we might find this information?" You may also want to use the 
Skeletal System Unit Introduction (below) to provide students with an overview of the unit. At 
the end of the week, give students the worksheet titled "The Bones Inside Us." (See Student 
Handouts below.)  
 

 
Unit Introduction  
 
 
Week 2: Assign each student a partner, provide students with a rubric for production of a 
PowerPoint presentation, and view the presentations with the entire class.  
 
Week 3: Assign students a new partner, and provide a rubric for the production of a Publisher 
newsletter. (Note: The newsletters can be sent home as a classroom communication tool and can 
also allow the teacher to assess what students have learned about the skeletal system.)  
 
Week 4: Assign students a new partner, and provide a rubric for the production of a Web site, 
starting with a Publisher file.  

http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/Bones.ppt


   

   
  

 
To download tutorials on creating newsletters and Web sites with Microsoft Publisher visit: 
http://www.microsoft.com/education/default.asp?ID=Publisher2000Tutorial  

Accommodations for Different Learners 
 

Resource Student  
These students can be paired with a specific partner of higher ability to enable the optimal 
learning environment for these students. 
 
Handouts  
 

 
Bones Inside Us Worksheet  
Assessment 

 
For the multimedia, newsletter, and Web site projects, students are given the following rubrics 
and told that these rubrics will be used to assess their work. 

   
PowerPoint 
Rubric 

Publisher 
Rubric 

Web Site 
Rubric 

 
 
Resources  
MSN® Learning & Research Plus/Dictionary and Thesaurus from Encarta®  
 
Virtual tour of a skeleton game to build a skeleton:  
http://www.medtropolis.com/vbody.asp  
 
Description of bone:  
http://www.innerbody.com/htm/body.html  
 
Overview of skeletal system:  
http://www.innerbody.com/htm/body.html  
 
Newton's Apple:  
http://www.ktca.org/newtons/14/bones12.html  
 
Great ProTeacher Web sites for bones (including a word search):  
http://www.proteacher.com/prosearch/search2.cgi?c=nil&s=skeleton&n=1  
 
 

***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  

http://www.microsoft.com/education/default.asp?ID=Publisher2000Tutorial
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/BonesWorksheet.doc
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/PowerPoint_Rubric.doc
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/PowerPoint_Rubric.doc
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/Pub_
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/Pub_
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/Web_Rubric.doc
http://www.microsoft.com/Education/DOWNLOADS/LessonPlans/Web_Rubric.doc
http://encarta.msn.com/encnet/features/dictionary/dictionaryhome.aspx
http://www.medtropolis.com/vbody.asp
http://www.innerbody.com/htm/body.html
http://www.innerbody.com/htm/body.html
http://www.ktca.org/newtons/14/bones12.html
http://www.proteacher.com/prosearch/search2.cgi?c=nil&s=skeleton&n=1
mailto:colburnc@howellschools.com
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 Carole’s Training Corner  
Happy March! Happy Saint Patrick’s Day!  

This month I will continue to visit buildings offering training sessions in various applications, including 
Outlook, Word, and Excel and peripheral training in Smart Boards. Also , take a minute to look at the 
results of the support staff technology survey both at the beginning of this newsletter and on my web site.  

If you have an idea for a technology training session that you would like to have me deliver at your 
school, please let me know via e-mail at colburnc@howellschools.com. I am happy to work with you to 
accommodate your technology training needs as best as I can.  

 Continue to check out my website for training updates: http://www.howellschools.com/~training 

Remember to keep smiling ~Carole ☺ 

 

Back to Top of Page 
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

 
JUMPING BACK IN A LONG DOCUMENT 
------------------------------ 
If you are editing a long document and you need to temporarily refer another place in 
the document, you can use this tip to make yourself more productive. There are two 
ways you can jump back and forth in your document. 
 
First, you can use the scroll bars to view the other parts of the document. The insertion 
point is still at your old editing position, even though it is off-screen. When you are 
through viewing the part of the document you needed to refer to, press one of the arrow 
keys or any printable character (including the Space Bar). You will be taken back to the 
exact place you were editing. Of course, if you pressed a printable character you will 
need to delete it. 
 
The other method is to use Shift+F5. This key combination is used to jump to the last 
three places in the document where you made edits. (Actually, it is four locations if you 
count the one where you first pressed Shift+F5.) You can press it once and you will 
return to where you were most recently editing. 
 
**
 
******************************************************************** 

ROTATING A DRAWING OBJECT 
------------------------------ 
Word allows you to create drawing objects in your document. These objects (such as an 
oval, rectangle, line, or AutoShape) are positioned on what is termed the "drawing 
layer," which is separate and distinct from the text that appears in a document. You 
generally create such objects by using the tools on the drawing toolbar. 
 
How you can rotate a drawing object depends on the version of Word you are using. If 
you are using Word 6 or Word 95, you can only rotate drawing objects in ninety-degree 
increments. To do this, follow these steps: 
 
   1. Select the drawing object. 
   2. Click on the Rotate Right tool on the drawing toolbar. 
 
If you are using a more recent version of Word (Word 97 or later), you can rotate the 
drawing object to any degree you desire. Simply follow these steps: 
 

1. Select the drawing object. 
2. Click on the Free Rotate tool on the drawing toolbar. Rotation handles appear at 

the corners of the drawing object. 
3. Click on a rotation handle and drag the object in the direction desired. 
4. Press Esc when you are done rotating the object. 

   
  

http://wordtipsgold@vitalnews.com/


   

   
  

 
If you know exactly how much you want to rotate the drawing object, you can also do 
the following: 
 

1. Right-click on the drawing object. This displays a Context menu. 
2. Choose the Format AutoShape option from the Context menu. This displays the 

Format AutoShape dialog box. 
3. Make sure the Size tab is selected. 
4. Change the value in the Rotation box as desired. 
5. Click on OK. 

 
You should note that Word allows you to insert text within an AutoShape. Rotating the 
AutoShape, however, does not result in the text within the AutoShape being rotated. 
Instead, you can only change the orientation of the text within the AutoShape, as 
described in other Word Tips. 
 
 
**
 
******************************************************************** 

PICTURES MOVE ON THEIR OWN 
------------------------------ 
Have you ever placed pictures in your document, expecting them to stay in a set 
location, and then you find that they moved around? This is not uncommon in Word, 
and typically can be traced to a misunderstanding about how Word handles pictures. 
 
When you place a picture in a Word document, you can place it either inline or floating. 
The default placement method depends on the version of Word you are using. Inline 
pictures are great, and will stay exactly where you put them, because they are treated 
like any other character in a paragraph. 
 
Inline pictures are great for some purposes, particularly for larger pictures. Inline 
pictures, since they are treated just like text, follow the alignment of the paragraph in 
which they are placed. Thus, if you center the paragraph, the picture is centered. 
Likewise, you can left- or right-align the picture by simply using the paragraph alignment 
tools on the Formatting toolbar. The drawback to inline pictures, of course, is that text 
doesn't wrap around them, and therefore you may not get the exact layout you want. 
 
Floating pictures are a different story. Floating pictures can do just that--float. Also, the 
picture can be formatted so that text floats around the picture. To control the floating 
behavior of the pictures, Word provides anchors that indicate a point in the document 
with which the picture is associated. You can see these anchors by choosing Tools | 
Options | View and making sure the Object Anchors check box is selected. Then, when 
you click on a floating picture, you will see an actual anchor character at the point in 
your document where the selected picture is anchored. 
 
To modify how the picture's anchor behaves, you simply need to right-click on the 
picture and choose Format Picture from the Context menu. Word displays the Format 
Picture dialog box. Then, on the Layout tab, click on the “Advanced” button. The 
resulting dialog box has a tab labeled Picture Position where you can specify the 



   

   
  

placement of the floating picture. (In other words, you can specify how the anchor 
should behave.) 
 
There are two important check boxes on the Picture Position tab; both are at the bottom 
of the dialog box. The Move Object with Text check box controls whether the object 
moves as the text to which it is anchored moves. Thus, if a picture is anchored to a 
paragraph, and you insert text before the paragraph, the picture is moved down as the 
paragraph--and its associated anchor--moves down the page. If the check box is 
cleared, then the anchor moves, but the picture stays put where you placed it. This 
check box is selected, by default, so pictures normally move with their underlying text. If 
you don't want them to move, clear this check box. 
 
The other important check box is Lock Anchor. This check box controls whether the 
anchor can move or not. Normally, if you click on a picture and drag it to a new location, 
the anchor for that picture is changed to the nearest paragraph. If you lock the anchor, 
the anchor stays put, even though you moved the picture. 
 
Simply understanding the controls on the Picture Position tab can solve many picture 
positioning problems. You should play with them to find out which combination of 
settings is best for your use of pictures. 
 
That being said, some people find that they can get better control of where pictures are 
placed simply by placing pictures in other objects. For instance, you may want to create 
a single-celled table and place your picture in the table cell. Likewise, you may want to 
create a text box and place the picture in the text box. Either approach is appropriate if 
you are more comfortable working with tables and text boxes than you are in working 
directly with pictures. In addition, using pictures in this way gives you other options that 
you would normally have. For instance, you can apply borders to the table cell 
or to the text box, thereby creating a border around your picture. 
 
**
 
******************************************************************** 

SPELL CHECKING YOUR WORKSHEET IN EXCEL 
------------------------------ 
Excel provides a built-in spelling checker you can use to proof (double-check) your 
worksheets. This tool works in much the same way as the spelling checker does in 
other Office applications. To run the spelling checker, follow these steps: 
 

1. Select the worksheet or worksheets that you want to be included in the spelling 
check. 

2. Choose Spelling from the Tools menu, or press F7. Word begins to check the 
spelling of your document, displaying the Spelling dialog box as it discovers 
potential errors. 

3. Respond to the spelling suggestions as appropriate. 
 
You don't have to spell check an entire worksheet; you can run the spelling checker on 
a range of cells, as well. To run the spelling checker on a range, do the following: 
 
   1. Select the cells you want to be checked. 
   2. Choose Spelling from the Tools menu, or press F7. 



   

   
  

   3. Respond to the spelling suggestions as appropriate. 
 
When the spelling check of the selection is complete, Excel displays a dialog box asking 
if you want to have the rest of your worksheet checked. Click on No to end the spelling 
check. 
 
 
********************************************************************* 
 
DELETING NAMES IN EXCEL 
------------------------------ 
There may come a time when you want to delete names you previously defined and 
used in Excel. To do this, follow these steps: 
 

1. Choose Name from the Insert menu, and then Define from the resulting submenu. 
Excel displays the Define Name dialog box.(It sounds strange to choose Define 
when you want to delete something, but that is the way Excel is designed.) 

2. In the list of available names, select the one you want to delete. 
3. Click on the Delete button. The name is removed from the list. 
4. Repeat steps 2 and 3 for other names you want to delete 
5. Click on OK to close the Define Name dialog box. 

 
 
 
 
********************************************************************** 

Back to Top of Page 

 

 

Great “Spring (Will it ever get here?)” Links For You to Try…     

http://childparenting.about.com/cs/projects/  

http://crafterscommunity.com/index.php/239  

http://www.craftsfortrade.com/   

http://childparenting.about.com/cs/projects/
http://crafterscommunity.com/index.php/239
http://craftsforkids.miningco.com/library/reviews/aafprwinter.htm


   
http://www.fastq.com/~jbpratt/education/theme/stpatricksday.html 

http://craftsforkids.miningco.com/library/projects/blshamcf.htm   

Back to Top of Page 

 

For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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